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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave

A reader gets an error message when copying and pasting text from the Web into Microsoft Works;
a reader wants to pin a file to the Start menu; a reader dreams of an instant-on PC; a reader wants
to preserve a Windows 3.11 and Excel 4 setup in @ modern machine.

Dear Digital Dave,

When | try to copy and paste something from a Web site to transfer it to a Microsoft Works word
processor document, | get an error stating, "The information you copied exceeds the size limit
for pasting into the word processor. Try reducing the size of your selection, and then copy and
paste again." However, this error pop-up occurs even if I'm trying to copy and paste something
as small as one word. What's up with that? How can | fix it?

Thanks in advance!

Ivy Stein
San Diego, CA

Dear Ivy,

While I don't use Microsoft Works, | have noticed that full-featured word processors can do funky things when you
attempt to copy from Web pages. | think this happens because the word processor is attempting to bring all of the
formatting from the Web page with it. It is also possible that the effect would vary if you tried another Web browser. (I
have experienced this variation in OpenOffice.org when copying from Google Chrome and Internet Explorer.)

A quick-and-dirty trick for cleaning up the text is to first copy it into a text editor, such as Notepad, then recopy it
(CTRL+C) from the text editor to the word processor (CTRL+V). This will remove all of the special formatting and
render clear text.

Any thoughts from other readers are welcome.

Digital Dave

Dear Digital Dave,

In your answer to Wayne Wood about where to find My Documents, you said once it is found
you can pin it to the Start Menu. | tried that, and when I right-click on My Documents there is no
selection to "Pin to Start Menu." | am using Windows 7.

Poz
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Dear Poz,

| should have been a little clearer. In Windows 7, the primary way to pin a folder to the Start Menu (or to the Taskbar)
is to left-click and hold on the icon, then drag it to the Microsoft Start icon or Taskbar, and release. The message "Pin
to Start menu” (add to Start menu), "Pin to Windows Explorer" (add to the Taskbar), or "Move to Desktop" (for
Desktop placement) will appear as you hover over the respective areas. If Windows Explorer is not already pinned to
your Taskbar, it will be added when you pin the new folder.

Digital Dave

Dear Digital Dave,

Do you think in our lifetime we will have a computer that, when you press "on," comes on like a
light bulb instead of each component waking up separately?

David Niles
Phoenix, AZ

Dear David,

My computer comes on instantly. All | have to do is move the mouse and I'm ready to go. The screen has been
turned off, but "comes on like a light bulb" when a key is hit or the mouse is moved. That's because | rarely ever turn
it off.

| know that is not what you meant, though. You want a computer that is completely powered down to instantly come
up when you flip the switch—and yes it is possible to come close to that, but it may be at some cost. You will need to
keep the various pieces of the system secretly powered up (minimum power requirements) and the operating system
preloaded into memory. (Loading the operating system into memory takes a good bit of time.) The more the computer
is solid state, the better. The iPad will boot up in about 10 seconds.

Here's an article listing some instant-on devices (en.wikipedia.org/wiki/Instant_on). Looks like there are some
options if you don't need full Windows functionality.

Most electronic devices take a few seconds to power on. The question is not whether there is an instant on, but
whether the time to functional use is too long for you. This is an individual judgment. Most people will tolerate a short
loading period, but if it gets too long—as was often the case with Windows Vista computers—it becomes a serious
aggravation. Manufacturers will build to the optimum—uwhat will sell while still keeping costs down. For those
applications requiring near-instant starting, customers will either pay a higher price or leave their computers running
all the time.

Digital Dave

Dear Digital Dave,

For nearly two decades | have been maintaining our household financial records and computing
our income tax payments using Excel 4.0 macros on a Windows 3.11 computer. (No, it is not
connected to the Internet. | back it up via serial line Kermit.) The computer is currently so old |
had to replace the BIOS battery last year. It is, of course, only a matter of time, hopefully years,
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before it dies.

My question is whether it will be possible to either install Win 3.11 on a partition of a modern
computer or run Excel 4 on a modern Microsoft OS? If so, how do | do it properly? | would
dearly like to avoid rewriting all my macro spreadsheets in Visual Basic!

Stewart A. Levin
Centennial, CO

Dear Stewart,

| don't know the immediate answer, but a little checking indicates that it may be possible to do all of the above,
especially if you do it in a virtual machine. Rather than wait for your current setup to die, | would get started on the
solution right now. If you are able to make it work, then you will be able to transfer all of your programs over before
the old computer crashes. If it turns out to be unfeasible, then you will have time to either rewrite your macros or get
one of the many financial programs that are now available.

| would recommend starting with a Windows 7 Professional machine. It includes a free download of Windows Virtual
PC, which may be able to run your Windows 3.11. (There is some evidence (blogs.msdn.com/b/
virtual_pc_guy/archive/2004/10/26/247793.aspx) that this may work.) If that doesn't do the job, then | have
seen some references (www.jacobdybala.com/windows-311-on-vmware) to running Windows 3.1 with the
virtual machine from VMware.

It looks like the Excel 4 files might open in any newer version of Excel, but it's difficult to verify. There may also be
conversion programs floating around that could convert these files to the latest formats—possibly even your macros.
I'd exhaust this route before messing with Windows 3.11 virtual machines or trying to get Excel 4 to run.

The best way to solve a problem that you know is coming is to get out ahead of it.

Digital Dave
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Dialing Into Videoconferencing
“|t's green, convenient and more personal than voice-only conference calls.”
by Pete Choppin

Videoconferencing services, software and hardware make chatting online via Web cam cheaper and easier than ever.

When you can't meet face-to-face, meeting Web cam-to-Web cam is the way to go. Whether you want to chat with a
friend or have an informal business meeting, videoconferencing is more personal than voice-only conference calling,
and it's a lot cheaper (and greener) than today's plane trips.

With the economic problems many companies have had to face, cutting costs is a common practice. The company |
work for is no exception. We realized that videoconferencing can accomplish the same thing as a face-to-face meeting
for a fraction of the cost. Videoconferencing is more personal than voice-only conference calling, and it's a lot cheaper
than the cost of airfare, hotels and food. But you need the right software and Web cam to get the most out of your
video meeting.

The newest videoconferencing applications feature improved interfaces, smoother video streaming and clearer audio.
While updated favorites Skype (www.skype.com) and SightSpeed (www.sightspeed.com/) still offer the best
free video calls on the Web, newer options have arrived on the scene with their own unique contributions to video
communications. Here are some of the services available as well as some of the top Web cams that add video to
enhance your communication.

Services
00V00o (Www.00ov00.com)

00Voo gives you videoconferencing with up to six participants in a slick, well-thought-out interface. To
this it adds file transfers, group text chat and community search. Though the video quality is
acceptable, it still lags behind that of SightSpeed, and audio tends to stutter.
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Paltalk Express (express.paltalk.com/)

Plenty of user-generated and original content and a good voice- and video-chat system make this a
useful service for large group chats, demos, seminars and more. Don't plan on doing any PC-to-
phone calling, however. For that, you'll need Paltalk Scene.

SightSpeed (www.sightspeed.com)

With 30 frame-per-second video, SightSpeed offers the sharpest Internet video calling around.
Version 6.0 brings an improved interface as well as some new features, such as the ability for Pro
users to record a video call locally. The new Web interface option and social-network integrations
make SightSpeed even more useful.

Skype (www.skype.com)

This impressive, mostly free voice-communications app and Web service just keeps getting better. It
offers free and easy voice calls, video calls and chat between Skype users as well as Skypecast
conference calls that delve into any topic imaginable and can include up to 100 Skype users from
anywhere in the world.

TokBox (www.tokbox.com/)

TokBox is a one-stop shop for all your video communication needs: video mail, conferencing with an
unlimited number of participants, and a public stream for your video rants. Its Web interface is
attractive and clear, and the desktop client, based on Adobe AIR, allows you to be available to your
fellow video chatters without requiring you to be logged into the site.

SIP-Based Softphones

Another popular technology for communication is the ability to use your mobile device as a phone. The software
application that allows you to do this is generally referred to as a softphone. Softphones communicate over a protocol
called SIP, short for Session Initiation Protocol. SIP is an IP telephony signaling protocol used to establish, modify and
terminate VolP telephone calls. The advantage of a SIP-based softphone is that it allows you to set up a full
videoconference using a cell phone or laptop computer.

When used in conjunction with VolP, softphones can then become a very economical alternative to standard
communication using LAN lines or cellular phones. Plus you have all the advantages of video and collaboration
conferencing. This is especially attractive for mobile users who may not always be able to get to an office for
conferences. But it can be equally useful for long-distance communication with family and friends. Instead of paying
high prices for traditional phone calls across long distances, using SIP-based softphones is free or low cost and offers
voice and video chat.

One such service, X-Lite from CounterPath, offers a full set of softphone capabilities including voice and video through
your mobile device as well as Instant Messaging, and a fully integrated personal address list. You do need to have a
VolIP or broadband service to use X-Lite.

Web cams

Logitech QuickCam Pro 9000 (reviews.cnet.com/webcams/logitech-quickcam-pro-9000/4505-6502_7-
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32509550.html?tag=prod.txt.1 ) $59 - $99

Logitech's QuickCam Pro 9000 Web cam easily outperforms other similar Web cams, and its high-quality video feature
makes it the best choice for Skype users. However, the high-quality video comes at a performance price. Just make
sure you have a high-quality computer to handle the video capabilities.

Microsoft LifeCam VX-5000 (computershopper.com.com/webcams/microsoft-lifecam-vx-5000/4505-
6502_7-33017045.html?tag=pdtl-list) $24.99 - $39.99

Despite its mediocre software, the Microsoft LifeCam VX-5000 proves its worth with outstanding image quality, useful
design and low price.

Logitech QuickCam Pro for Notebooks (computershopper.com.com/webcams/logitech-quickcam-pro-
for/4505-6502_7-32509549.html?tag=pdtl-list) $60.99 - $99.99

The Logitech QuickCam Pro for Notebooks provides unmatched image quality, but its design could be improved. The
reviews claim a clear, bright video output, but constantly readjusting the camera atop your laptop will get annoying.

Creative Live Cam Voice (computershopper.com.com/webcams/creative-live-cam-voice/1707-6502_7-
31884379.html?tag=pdtl-list) $48.99

With its beefed-up audio features, the Creative Live Cam Voice is one of the best overall cameras for IM and Internet-
based voice conferencing.

Microsoft LifeCam NX-6000e (computershopper.com/peripherals/reviews/microsoft-lifecam-vx-7000-
webcam) $50

A decent Web cam for work or play—but don't believe the high-res hype.

Long-distance and international calling is still fairly expensive using conventional phone calling, but if you want to avoid
these charges there are plenty of alternatives with VolP and SIP-based softphone services. Voice, video and
messaging services are now possible using a computer and an Internet service, allowing a more feature-rich
communication experience.

Pete Choppin has been an IT Professional for over 15 years. He currently works as a network and systems
administrator for a company called Albion based in Clearfield, Utah. He has experience in all types of hardware,
software, and networking technologies. He is proficient in many operating systems including Linux, Windows and
Macintosh. His interests include cooking, sci-fi, computers and technology, and Web design—a semi-professional
endeavor, having designed Web sites in the dental field, e-commerce businesses, and for the Boy Scouts of America.

Pete has been a devout reader of ComputorEdge since 1990 and contributes regularly to featured articles as well
as the Linux Lessons section of ComputorEdge. He can be contacted at pchoppin@comcast.net but prefers to
have comments on ComputorEdge articles submitted to the editor and posted for the benefit of all readers.

8 of 39



ComputorEdge 10/1/10

Return to Table of Contents

Place a Call to the Future
“Will Skype replace your telephone?” by James Hartnett

Skype has captured the market and mind-share of Internet telephony, but the videoconferencing industry is still in its infancy—
and Google is dipping its gigantic toe into the water.

Videoconferencing has always been part of our plan for the future. Like food pills, flying cars and cities on the moon,
videoconferencing was supposed to be part of our lives by the year 2000.

Here itis, 2010, and | don't have a flying car, can't vacation on the moon, and there's not a food pill in sight. But
videoconferencing is something that we do have, although it doesn't quite live up to the quality we had all imagined.

Skype was a 2003 European startup. The concept was simple: use the Internet to carry voice traffic that otherwise
would be carried over a dedicated phone line. But while the concept was simple, reality was a lot more complicated.
Skype was not the first to try to do voice over the Internet (or "voice over IP," as telecom geeks call it). There is a real
problem with carrying voice traffic—the Internet was not built for that sort of connection.

The Hard Part of Videoconferencing

When you are transferring a file, or opening a Web page, you are downloading a bunch of data to your machine, but it
doesn't have to happen smoothly. If you click on a Web page and it does nothing for a second, then suddenly your
computer is flooded with information, that's OK.

The same is not true for a voice call. With voice, a delay of a second is noticeable, and it doesn't do anyone any good
to have voice traffic arrive all at once—it's a drawn-out stream of data, and it must be delivered in the correct order,
with little latency. It's a real challenge. Video is the same, but 100 times harder.

But Skype made it work. With some fancy algorithms and good software, Skype managed to package up your voice
and video in such a way that it travels over the Internet with little delay.

What Skype Does

Skype is attempting to replace your telephone. If you are sitting at your computer, they want you to open your Skype
application and use your mouse and keyboard to place the call. Your computer must have a microphone (and,
optionally, a Web camera) and speakers.

Skype calls can be placed to other computers
on the Net for free (anywhere in the world),
and to domestic and international landlines
and mobile lines for a charge. Although its
prices have crept up recently, Skype is still
much more affordable than my local landline.
A new feature that Skype is introducing is a
landline number that others can call to reach
you on your computer through Skype.

Skype offers the functionality of a regular
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landline, and at lower prices, but it doesn't

stop there. Skype really shines when it comes

to connections between two or more Skype

users with computers on both ends of the

connection. With a couple of cheap Web

cams, and a huge amount of data traffic,
video phones become a reality.

The simple video-phone connection is not hard to understand. They see you, and you see them. But it is not the end of
the story, just the beginning. Recent releases to Skype software allow for multiple participants to videoconference
together. This was technology that used to cost tens of thousands of dollars, and is now available with a $30 Web cam.

To sign up for Skype just go to its Web site and download the application. Create a Skype name for yourself, and
you're ready to go.

Beauty Is in the Eye (and Bandwidth) of the Beholder

The Skype software works well, but that's not the main problem with voice, or video, over the Internet. The problem is
one of network capacity.

The normal business computer is connected to a dedicated network (not wireless), with a dedicated connection to the
telecommunications network. This connection is always on, always available, and used exclusively by the company
that pays for it. The hardware is modern, well-maintained and properly configured. As a result, using Skype at work
results in a crisp, high-quality call.

The average home computer is connected to the Internet, perhaps over a wireless line in the home, over a DSL or
cable TV modem, which is shared by as many subscribers as the provider can pile on. The equipment is frequently
old, and configuration may be spotty. For some people, Skype connections from home will be great. For others, video
quality will be poor. Don't blame Skype—blame your network.

Getting Better Quality
It is possible to improve the quality of your Skype calls.

The first step is to eliminate, if possible, any wireless link in the chain. If you are using wireless, then somewhere in the
house there is a computer that is actually connected to the phone line with a real, old-fashioned wire. Use that
computer to make Skype calls.

Still not good enough? Make sure you shut down all applications that load the network. There's only so much capacity,
and if Firefox is open in the background, downloading a big file, or with some busy Web pages that self-refresh every
few seconds, there will not be much left for Skype.

If that's still not good enough, it's time to measure your bandwidth. If it's not at least close to what you paid for, you can
try calling your phone company and complaining. But there may be little that can be done.

The Rise of Skype

Skype quickly captured the market and mind-share of Internet telephony. Particularly in the corporate world, Skype is
very commonly used for conference calling. Since businesses already have good network connections and plenty of
computers, what could be more natural than using the Internet to eliminate expensive landline calls, especially for
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international calls?

Skype now has a half-billion user accounts, with more than 40 million daily users. It has become the largest carrier of
international phone traffic.

Skype Is Not Alone

With all its success, it's quite natural that Skype would attract competitors. One example is VoxOx. As always, the
competitors seem to work a little bit harder and faster, in an attempt to catch up to the big player. VoxOx offers
everything that Skype does, but with a welcome addition: a way to handle all the different social media (Facebook,
StumbleUpon, Twitter, and others I've never heard of).

The Google-Apocalypse?

Although Skype is the world's largest international carrier, and hoping to raise $100 million in an upcoming stock
offering, there has got to be one thing it worries about: Googlification of voice over Internet.

Like the eponymous alien of B-movie classic The Blob, Google seems to engulf everything eventually (see Figure 1),
and it already offers both free video chat, and a mobile phone platform (Android). It won't be long until these two
pseudopodia of the Google blob surround Skype and its tiny little competitors. Ominously, at the end of 2009, Google
acquired the Gizmo Project, one of Skype's competitors.

Figure 1. Google eats Earth.

And another sign of things to come: Google's Gmail now allows users to call regular landlines and mobile phones, for
free in the United States, and at what it calls an "insanely low rate" internationally.

| wish Skype all the best, but | don't know if it can survive the Google onslaught. With all its customers, traffic, and
mind-share, like Facebook (and unlike Google), it has not quite found a revenue model that works.
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Hopefully I'll be able to someday place a video call from my flying car to the hotel on the moon. When | do so, will it be
Skype, Google, or someone else who carries the call? Only time will tell.

James is a writer and software developer who has been with the free software movement from the beginning. He lives,
writes, and programs in sunny Colorado.
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Windows 7 Tips and

Tricks

“Windows 7's Built-In
Problem Solver” by Jack
Dunning

Windows 7 has a special feature
called Problem Steps Recorder
that will copy all of your activities
and place them in a zipped
MHTML file that is opened and
read by Internet Explorer. This
way you can record the activities
that are causing you a problem.

Nothing is more awkward than trying to describe a computer problem over the phone. The best possible option may be
for the computer expert to hook up with you over the Internet with Windows Remote Assistance (available in all
versions of Windows 7, Vista and XP). However, if you don't have an Internet connection or want to save the problem
for a later time, Windows 7 has a special feature called Problem Steps Recorder. This program will copy all of your
activities (including screen shots) and place them in a zipped MHTML file that is opened and read by Internet Explorer.
This way you can record the activities that are causing you a problem (or if you want to demonstrate to someone how
to do a computer activity in Windows 7), and then e-mail it a friend or expert.

The first step is to load the Problem Steps Recorder by entering psr into the Search programs and files field of the
Start menu. You can also use the words "step" or "record" to get the Control Panel help to "Record steps to reproduce
the problem."” Any of these approaches will open the recorder as shown in Figure 1. There are three options that are
fairly self-explanatory: Start Recording, Stop Recording and Add Comment.

Figure 1. The Windows 7 Problem Steps Recorder.

To start recording, click the Start Recording button. All of your activities will be annotated while you do your computing.
The clock at the right will run while it is recording. The Start button will turn into a Pause button in case you want to
temporarily stop recording. Click Resume Record to continue. (If you use the Stop button, you will need to start over
again if you want to add more steps to the recording.)

If you need to add a special comment or explanation at any point, click Add Comment. A text window will open and the
screen will fade. Type in your comment, then use the mouse to drag a box around the area of interest. In the final
report the comment will appear with the highlighted area inside a red box as shown in Figure 3 further below.

When you have completed the steps in your computer problem and click Stop Recorder, a Save window will open,
allowing you to name the zipped folder with the recorded data. The zipped folder is now ready for copying or e-mailing.
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You can open the data file by double-clicking on its icon. Internet Explorer will open the file as shown in Figure 2. The
data file is broken into three parts. First are the viewing options:

* Review the recorded problem steps
* Review the recorded problem steps as a slide show
* Review the additional details

The first and third options merely jump to the appropriate place in the file. The second option offers a slide show of the
steps in (what appears to be) real-time.

Figure 2. The Windows 7 Problem Steps Recorder report supplies three options: Review the step, see a slide show of the steps,
or review the additional details.

The second part of the data file includes each problem step with a screen shot and description of the action. If you
added a comment with a highlight, it will appear in this sequence, as shown in Figure 3.
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Figure 3. The Windows 7 Problem Steps Recorder.

The final section is more detail about each of the steps, including the program name and version (see Figure 4).
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Figure 4. The Windows 7 Problem Steps Recorder.

The next time someone asks me to tell them how to do something on the computer, I'm going to record it and e-mail it
to them.

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 1983.
Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached at
ceeditor@computoredge.com
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Wally Wang's Apple Farm
“Video Calling” by Wally Wang

FaceTime makes videoconferencing fun and easy, and also threatens
the long-term survival of cellular phone networks. Also, disruptive
technology spawns new technological waves; Runtime Revolution is
now LiveCode 4.5; Ada programming on the Macintosh; using
Microsoft Office files on the iPhone/iPad; the HP Slate is giving anti-
Apple critics some joy; another confusing Microsoft ad; and a tip on
changing the orientation of the iTunes window buttons.

If you want to make a video call on a Macintosh, you can rely on iChat, which requires a free AOL Instant Messenger
(AIM), AOL, MobileMe, or ICQ account. With iChat, you can videoconference among multiple people (provided
everyone has a fast enough Internet connection). However, with the introduction of FaceTime on the iPhone 4 and
iPod Touch, it's safe to say that FaceTime will work its way to the Macintosh and eventually replace or become part of
iChat.
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Figure 1. FaceTime is Apple's new videoconferencing open standard.

Since FaceTime is an open standard, other companies will likely adopt FaceTime and soon you'll be able to
videoconference with anyone who has an Internet connection. Essentially, FaceTime makes videoconferencing fun
and easy, and also threatens the long-term survival of cellular phone networks.

The FCC recently approved the use of "Super Wi-Fi," (www.tweaktown.com/news/16884/
fcc_officially_gives_super_wi_fi_the green_light/) which will take over the old spectrum that television
channels used to have. The two main features of Super Wi-Fi are its fast speed and longer range, essentially putting
rural areas within reach of Wi-Fi signals rather than limiting Wi-Fi to a single household.

Consider what might happen if entire cities offered Super Wi-Fi networks. Now you could make a FaceTime video call
without going through a cellular phone network at all. What will that do to the cellular phone companies? Unless they
rapidly convert to Super Wi-Fi to supplement and eventually replace their cellular network, they'll be disappearing as
quickly as Blockbuster Video.

If every place has Super Wi-Fi available, that will be the new cellular network and we'll all be able to use FaceTime-like
video calling to do everything our current mobile phones can do and more.

Ordinary audio phone calls might be nice when calling in sick and pretending to be ill, but for many people, video
calling will be more fun and convenient (especially since you'll have the option of chatting through video or just through
audio), and that will spell the end of audio-only calling as quickly as telephones have replaced Morse code and the
telegraph.
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After decades of promises from the phone company that video calling would soon arrive (www.scribd.com/
doc/25746873/1956-Aug-24-Hutchinson-News-Herald-Hutchinson-KS-Paleo-future), it may already
be here courtesy of technology like FaceTime.

I

.......

e

WHO0'S CALLING will be no secret, wilh help of Plcture-Phone
demonsiraled al electronics convention by Bell Telephone Lab-
oratories. Man usging phone sees caller on picture tube, and is
photograpbed himselfl by TV lens just above Iit.

Figure 2. Bell Telephones hinted that video calling would soon arrive in 1956.

19 of 39



ComputorEdge 10/1/10

Disruptive Technology

Disruptive technology is anything that changes the playing field for one or more markets and completely eliminates the
advantage of the current leaders. Microsoft actually innovated this way back in 1991 when it introduced Visual Basic,
which essentially killed the current programming leader, Turbo Pascal, and spawned a slew of copycats that adopted
the "Visual" moniker, such as Visual dBASE.

Visual Basic wasn't just a new product, but a whole new way of looking at programming. For the first time,
programmers could design a bug-free user interface quickly and easily and focus their programming skills simply on
making their program work.

Identifying such disruptive technology is the key to catching the next technological wave. Reading a slightly dated, but
still interesting book like The Innovator's Guide to Growth (www.amazon.com/gp/product/15913984607?
ie=UTF8&tag=the15minmovme-20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1591398460) can help
you understand how creative companies can use disruptive technologies to succeed.

Competing is hard, especially against entrenched, well-funded and powerful competitors. However, competing is much
easier if you just rearrange the rules in your favor through disruptive technologies. Trying to beat Mike Tyson in a
boxing match might seem impossible, but if you rewrite the rules so Mike Tyson's hands are tied behind his back while
you have an Uzi sub-machine gun, suddenly the task doesn't look so daunting.

Apple's iPhone and the iPad have similarly rearranged the rules and given us a whole new way of looking at
computers. Before the iPhone, a typical mobile phone offered plenty of features and the ability to download apps, but
they were so hard to use and clumsy that few people ever bothered. With the introduction of the iPhone, Apple rewrote
the rules for what a smartphone should do by making a phone act more like a handheld computer, essentially killing
the market leaders (Nokia and BlackBerry) while spawning a legion of copycats (Android and webQS).

Many businesses are using the iPhone (www.macworld.com/article/154245/2010/09/iphonebiz.html?
Isrc=top_1) as more than just a portable telephone. DriveSavers, a data recovery firm, has developed a simple
iPhone app that graphically shows customers what problems might have affected their hard disks.
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Figure 3. The DriveSavers iPhone app shows common hard disk problems.

The Army is also using smartphones (swampland.blogs.time.com/2010/09/23/hey-soldier-youre-in-the-
iphone-army-now/?hpt=T2), such as the iPhone to provide Army training manuals in electronic form. Now
soldiers can read these manuals without lugging around backpacks full of printed paper.

The iPad is likewise disrupting markets way beyond computers. Bone's, a high-end steakhouse in Atlanta, now gives
diners an iPad to peruse the restaurant's wine list (www.nytimes.com/2010/09/15/dining/15ipad.html?_r=1).

21 of 39



ComputorEdge 10/1/10

Figure 4. The iPad can be an intelligent wine list.

Besides saving the cost of printed wine lists, the iPad wine list can also provide background information on different
types of wines, allowing diners to educate themselves about various wines and what type of wines might go best with
certain foods. Bone's discovered that giving customers the ability to browse and educate themselves at their
convenience actually increased wine sales by 11 percent.

Hyatt Hotels has found that its employees can work more efficiently in registering guests, tracking meetings, and
storing notes using an iPad (www.apple.com/ipad/business/profiles/hyatt-hotels/).

Hyatt's sales team even feels that the iPad has transformed the way they do business. Rather than carrying bulky
portfolios, they can show potential clients digital images or videos of property highlights. "It's a great tool to sell the
hotel. Especially in this industry, where you've got to show bedrooms, banquet space, all the things we have to offer
guests."

The iPad is a whole new way of looking at computers. Instead of forcing people to learn the arcane terminology and
commands needed to use a computer, the iPad (and iPhone) makes using a computer intuitive and fun. Now people
have time to be creative rather than waste their time learning yet another tip for keeping their computers working
before they fall apart once more.

Runtime Revolution is Now LiveCode 4.5

One of the earliest examples of Apple's innovation (and ultimate incompetence) appeared in the mid-'80s when Apple
introduced HyperCard, a simple programming tool that helped turn non-programmers into programmers and even
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inspired the World Wide Web with its hypertext linking features.

Back then, people bought the Macintosh just to use HyperCard, yet Apple didn't recognize the connection between
people buying the Macintosh and people wanting to use HyperCard. As a result, Apple let HyperCard languish and
ultimately die. Not surprisingly, sales of the Macintosh nearly dried up and died.

A Scottish company called Runtime Revolution (www.runrev.com/) soon licensed, and ultimately purchased, a
HyperCard clone dubbed MetaCard, which it renamed Runtime Revolution. Now at version 4.5, the company has
renamed the tool as LiveCode (www.runrev.com/products/livecode/livecode-platform-overview/).

LiveCode closely mimics HyperTalk, the simplified programming language that made HyperCard so popular. Besides
making programming easier for novices, LiveCode also provides a cross-platform compiler so you can create a
Windows, Linux, or Mac OS X program from a single file.

For those anxious to program the iPhone/iPad, LiveCode offers an optional iPhone/iPad development kit so you can
use the simplified LiveCode language to create your own apps. If you've always wanted to write a program for the
Macintosh or iPhone/iPad, but found the details of learning Objective-C too complicated, try LiveCode and see if you
can convert your good idea into a working program.

Ada Programming on the Macintosh

If you want to write Macintosh programs, you can use a tool like LiveCode or take the time to learn Objective-C.
However, Objective-C, like nearly all variations of C, gives you the ability to manipulate memory. This power can be
used to create lean, efficient programs, but invariably it also creates buggy programs because programmers must
manipulate memory carefully, and if they forget to do that, their programs can wind up crashing or even bringing down
the entire operating system at the same time.

One alternative to this philosophy of "giving power to the programmers and hope they don't mess up" is embraced by
other programming languages like Ada. With Ada, the philosophy is to give as much power to the programmers as
possible, but make it impossible for them to mess up. This is the reason why Ada is heavily used in the aviation
industry, because software flaws in avionics computers could potentially bring down an entire airplane.

If the thought that the computer industry prefers machine efficiency over reliability sounds horrifying, then you're not
thinking like a typical tech-enthusiast who cares more about features and power rather than actual usability. After
comparing the benefits of C vs. Ada, Boeing chose to use Ada for its 777 airplane, citing greater reliability (www.
aonix.com/boe-777.html).

To explore Ada programming on the Macintosh, grab a free copy of MacAda (www.macada.org/macada/
Welcome.html). Unfortunately, the MacAda tools aren't as polished as Apple's Objective-C compiler, so you may
wind up wrestling with MacAda just to get it to work. Still, if you want to explore an alternative programming language
that's designed with reliability in mind as opposed to machine efficiency, take a look at the Ada programming language
on the Macintosh with MacAda.

Using Microsoft Office Files on the iPhone/iPad

Although Microsoft plans to release a new version of Office 2011 for the Mac in October, it doesn't have any plans to
release a version for the iPhone/iPad. If you want to do word processing, spreadsheet, or presentation work, you'll
need to rely on Apple's own iWork office suite.
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Initially, iWork for the iPad lacked file-format compatibility with Microsoft Excel and PowerPoint, allowing you to import
Office files but not allowing you to export them back out again. Fortunately, Apple's latest update adds a handful of
new features to Pages (word processor), Numbers (spreadsheet) and Keynote (presentation), where Numbers can
now export files to Excel (.xIs) format and Keynote can export files to PowerPoint (.ppt) format. (Pages could always
export Word .doc files.)

With this import and export ability for Office files, iWork on the iPad can now help you work away from your computer,
yet still provide a complete office suite for creating or editing word processor documents, spreadsheets, or
presentations.

For those who need to create, edit and view Word and Excel files on an iPhone or iPod touch, you can't use iWork, but
you can use another app called Office2 (www.bytesquared.com/products/office/iphone/default.asp). Like
iWork on the iPad, Office2 lets you work with .doc and .xls files so you can write and edit on the go. However, Office2
lacks the ability to use PowerPoint files.

Figure 5. Office2 brings a word processor and spreadsheet to the iPhone and iPod touch.

Leaked Video of HP Slate

One odd characteristic of anti-Apple critics is that they find every reason possible to criticize anything made by Apple
(without bothering to try any Apple products, of course), and then when another company copies Apple's design, they
rush out and eagerly embrace this copycat design.

For anti-Apple critics who still believe that the iPad is useless, they can eagerly await this iPad-clone from Hewlett-
Packard (www.electronista.com/articles/10/09/25/full.specs.enterprise.and.consumer.editions/). The
video demonstration of this HP Slate shows a tablet running Windows 7, so now you'll be able to run all your favorite
Windows programs on a tablet device, including Flash.

The HP Slate also includes front and rear-facing cameras, a virtual keyboard, and the ability to detect touch gestures.
Because it's running Windows 7, you can control the tablet using the familiar Start button in the bottom-left corner of
the screen.
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Until Hewlett-Packard officially announces this slate device, nobody will know how much the HP Slate will cost
compared to the iPad. In any case, anti-Apple critics will finally be able to buy an iPad clone and cheerfully proclaim
that the iPad is totally worthless while they extol the versatility and usefulness of a device that closely mimics the
iPad's form and functionality.

Another Confusing Microsoft Ad

Microsoft may not innovate new products, but it has a knack for coming up with confusing and conflicting
advertisements. The latest head scratcher from Microsoft is an ad for the upcoming Windows Phone 7 phone
operating system (www.youtube.com/watch?v=x3yJkql3rBo&feature=player _embedded).

The ad gently chides people for spending their lives staring into their phones, then the ad concludes by trying to
convince everyone to get a Windows Phone 7 phone.

Huh?

This would be like a commercial that explains how cars pollute the air and waste fossil fuels, and then ends by trying to
convince everyone to buy a new Ford.

If Microsoft's advertisements are any indication of its leadership, it's no wonder that the company's image continues to
flounder in the marketplace. After watching ads from Microsoft, will anyone associate its products with innovation,
excellence and efficiency? Or will they likely shake their head in confusion and wonder what message Microsoft is
trying to promote? If this is part of Microsoft's planned budget of $400 million to promote Windows Phone 7, someone
at Microsoft should start asking for a refund from their advertising agency.

* * *

If you've upgraded to iTunes 10, you may notice the strange placement of the window Close, Minimize and Maximize
buttons in the upper-left corner. Instead of appearing horizontally like most Mac OS X windows, iTunes 10 displays
them vertically.

To fix this problem, run Terminal (buried inside the Utilities folder in your Applications folder) and type:

defaults wite com apple.i Tunes full-w ndow -1

Press Return, restart iTunes 10, and the buttons should now appear horizontally.
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Figure 6. You can change the orientation of the iTunes window buttons.

In the early days, before Wally became an Internationally renowned comedian, computer book writer, and generally
cool guy, Wally Wang used to hang around The Byte Buyer dangling participles with Jack Dunning and go to the gym
to pump iron with Dan Gookin.

Wally is responsible for the following books:

Microsoft Office 2010 for Dummies (www.amazon.com/gp/product/04704899877?
le=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470489987),

Beginning Programming for Dummies (www.amazon.com/gp/product/04700887027?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470088702),

Beginning Programming All-in-One Reference for Dummies (www.amazon.com/gp/product/0470108541?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470108541),

Breaking Into Acting for Dummies with Larry Garrison (www.amazon.com/gp/product/0764554468?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0764554468),

Steal This Computer Book 4.0 (www.amazon.com/gp/product/15932710507?
ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271050),

My New Mac (www.amazon.com/gp/product/1593271646?ie=UTF8&tag=thel15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271646),

My New iPhone (www.amazon.com/gp/product/1593271956?ie=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271956),

My New iPad (www.amazon.com/gp/product/1593272758?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593272758),

Strategic Entrepreneurism with Jon Fisher and Gerald Fisher (www.amazon.com/gp/product/1590791894?
le=UTF8&tag=thel5minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1590791894),

How to Live With a Cat (When You Really Don't Want To) (www.smashwords.com/books/view/18896).

When not performing stand-up comedy or writing computer books, he likes to paper trade stocks with the video game
Stock Reflex (www.plimus.com/jsp/download _trial.jsp?contractld=1722712&referrer=wwang), using
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the techniques he learned from a professional Wall Street day trader.

In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15 Minute Movie
Method." (www.15minutemoviemethod.com/) Wally can be reached at wally@computoredge.com.
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Rob, The ComputorTutor:
Technology Solutions

“Open Office Spreadsheets” by Rob
Spahitz

This week we continue our investigation of
OpenOffice, a free competitor to Microsoft's Office
suite. Today we start exploring Calc, which is the
competition for Excel.

This week we continue our investigation of OpenOffice, a free competitor to Microsoft's Office suite. Today we start
exploring Calc, which is the competition for Excel. As a reminder, you can download Open Office from www.

OpenOffice.org.
Calc

After installing the entire OpenOffice suite, you should find Calc available from your Start button's menus, as with other
installed applications. In my case, | can launch Calc from All Programs/OpenOffice 3.2/OpenOffice.org Calc. | see the
application seen in Figure 1.

Figure 1. OpenOffice's Calc Program.

So far it looks very similar to Excel. However, as mentioned with Writer, the toolbars look a bit different but seem to
offer very similar functions.
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File Menu

Quickly scanning through the menus, | see that the File menu contains options to create a new spreadsheet or a new
file of any of the other types in the OpenOffice product (such as a Writer "Text Document”). Similarly, you can open an
existing file of any type from the OpenOffice product.

| also see a Wizards menu, but the entries seem to be unrelated to spreadsheets. For example, | see wizard entries for
Letter, Presentation and Web Page. Although MS Excel lets you do any of these (and Calc probably does too), those
are not normal spreadsheet functions, so | will skip them.

Next you have Close and a variety of Save options (just Save, Save as a different name, Save All).

Further down is the option to Export. When | select that, | see only the option to save as a PDF file. | assume that you
can either download plug-ins to save other things or maybe there are more options coming in a future version.
Meanwhile, if you want to save the spreadsheet as a different type of file (like MS Excel), you can do that from the
Save As option, as seen in Figure 2.

Figure 2. Calc Save Options.
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Aside from the ODF format, which seems to be the original Calc format, there seems to be a new format specifically
for OpenOffice (rather than what | expect is probably the Open Document Format—ODF) and formats for various older
versions of Excel. Since the formats from Excel 2000, 2002 and 2003 are the same, it looks like these will work with
the version that's still embedded in many people's machines. However, if you want the newer Excel 2007/2010 format,
you'll probably have to wait for a new translator to get written and released in a future update, or you'll have to Save As
the 2000 format and let the recipient open it in the new version of Excel, which should work fine.

The last choice is Excel 2003 XML. I'm not familiar with this, but | wonder if that is supposed to be Excel 2007 XML,
which is how Microsoft set up these new products. Or maybe these guys know something | don't, which is certainly
possible since Microsoft probably anticipated changing formats and may have released an update that included XML
format for its 2003 product. Just a little aside, XML stands for eXtensible Markup Language, which is very similar to the
Web page language HTML, except that you can define your own codes if you make an XSD file (XML Schema
Definition) available to allow for translation of the XML file.

Also in the Save section you see CSV as an option, which is a very common generic format for saving files for just
about any tool on the market that wants database-like information.

Back to the File menu, there's also an option to Send the Document as E-mail. This seems like an interesting feature,
but probably just opens your default e-mail program and attempts to add the current file as an attachment. Still, that
seems like a nice touch.

A bit further down was Preview in Web Browser. That sounded interesting so | tried it and it created a temporary
version saved as an HTML Web page, with the cells saved inside a Web page HTML table. Oddly enough, this doesn't
follow the current HTML standard (version 4.01) that suggests lowercase tag elements and attributes and quoted
values. Either way, any decent browser will have no trouble interpreting this page if you decided to save it for your
favorite Web site to display.

Finally, just before the Exit option, there are a few options related to printing. You can preview the page before
printing, change printer settings, or perform the print. These seem to show pages very similar to the standard printer
dialog boxes (although they are slightly different in appearance.)

Edit Menu

As with the File menu, many of the choices here are similar to what you would expect. Aside from Cut, Copy and
Paste, there's also Paste Special. | went over this in my Excel series. It basically gives you alternate pasting options,
such as text, formatting, formulas, etc.

In addition to these, the Edit menu includes features for undoing changes, comparing documents, and setting header
and footer sections for printing.

Beyond these, you can fill a collection of cells with values or use the Fill Series, which works a bit differently from the
one in Excel (which | always thought needed some help anyway, but it looks like this one does too—I'll explore that
another time).

Aside from these, you also get various delete options (cell contents, cell boxes, sheets and line breaks) and an option
to work with plug-ins (which didn't seem to work for me, so there must be more to it).

View
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In this menu, as seen in Figure 3, you can adjust how the page will display and work with other settings.

Figure 3. View Menu.

You can add custom toolbars; and show or hide the formula, status bars and column and row headings.

The Value Highlighting option seems to simply color the values of cells. At some point, I'll investigate this further, but if
you know what it's about, drop me a line. Or check the help files and send me your interpretation.

Next down is Data Sources. This would be a way to use Calc as a displaying tool for data located elsewhere, such as
in a separate database. Excel has a feature that integrates very well with Access to grab database information, so I'm
sure this is similar.

Next down, Navigator, seems to be an interesting add-on. As seen in Figure 4, this offers an alternate way to navigate
around the spreadsheet and other components added on top of the sheet.
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Figure 4. The Calc Navigator.

Other Menus
Continuing on to other menus, let me see what stands out for future investigation.

The Insert menu lets you add rows, columns, cells and sheets. You can insert functions (and this will need much more
investigation).

| see you can also work with Named cells, and Calc seems to have copied the same confusing menus that exist in
Excel, further reinforcing that the makers of Calc seem to have copied most of their functionality from Excel.

Just as an aside, in many of Wally Wang's Apple articles, he knocks the many companies that copy Apple's innovative
ways (especially in iPhones). Although there's some value in creating original products, sometimes copying and
improving existing products creates a superior experience. So far that's what | see in OpenOffice. The biggest problem
is that when the leader changes directions (like Microsoft's new Ribbon bar and new file formats), products like this
may need a lot of effort to move forward.

The Format menu includes a feature for Conditional Formatting of cells and also seems to offer the Excel 2003 limit of
three formats per cell (which was dramatically expanded in Excel 2007). | suppose that if they offered more than three
formats, then saving in Excel 2000 format would force the file to lose certain features.

In the Tools menu there's something called Detective, which seem to offer the same features as Excel's Formula
Auditing menu. This includes a feature to let you explore the relationship between references in cells. In Excel this is
also useful if you don't get what you expect in a complex formula (Evaluate Formula), but | don't see that feature here.

Also in Tools, | see an option to Protect the sheet. While trying to use it the way Excel works, it didn't work for me in
Calc. Since all the pieces seem to be there, I'm guessing that it simply functions a different way. Although some of the
functions are there (locking access to the values of cells), | can still click on a cell, which is denied in Excel. Maybe
that's by design, but it's also different enough that I'll have to think about it to see if it's better, worse, or just different.

The Data menu still seems to offer Sorting, Filtering and Subtotals. As | continue to test, I'll see if these work the same.
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In the Windows menu, | still see the Split and Freeze options. These were great features of Excel and I'm happy to see
that they seem to match the same functionality.

Last, but not least, the Help menu has an option to Check for Updates. When | tried it, | had to allow my firewall to give
it access to check for updates. It told me that it was up to date, so I guess nothing has changed in the five weeks since
| downloaded it.

Summary

So there's the quick tour. So far it looks very similar to Excel, but also sufficiently different. In my brief view it seems to
be a bit less functional than Excel, especially compared to Writer, which seemed much closer to Microsoft Word.

And as with Writer, | will start to put this through the wringer in the next few articles. If you have specific things to try,
let me know and I'll give my personal opinion of how it handles the task and how it compares to Excel 2003 and Excel
2007.

Meanwhile, enjoy this free alternative to the Microsoft Office suite.

Rob has been in the computer industry for over 25 years and is currently a part-time teacher, offering classes in Excel,
Access, Visual Basic, and a variety of other technical tools. He has loved ComputorEdge since 1990 and can be
contacted at RSpahitz@Dogopoly.com.

Looking for a great boardgame? Grab a copy from DOGOPOLY.com (dogopoly.com) and have a
dog-gone great time.
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Beyond Personal
Computing

“Kursing the Keyboard” by
Marilyn K. Martin

Who knew that such a deceptively simple
and necessary piece of hardware could be
the source of such havoc?

There are all sorts of computer keyboards out now. The high-end keyboards have fancy (and expensive) "ergonomic”
designs, with pleasing curves and extra padding for palms or wrists, mainly to avoid or relieve carpel-tunnel syndrome.
Or maybe to just impress your nearby cubicle-mates, as you loudly tack your former hand-brace to your cubicle
doorway. Sort of like going "Nah-Nah-Nah! All those years of wearing that frickin' brace finally paid off!"

Although that three months you were out for hand surgery and recovery was probably more instrumental in your boss'
decision to buy you that snazzy new ergonomic keyboard. Especially when other employees had to search through
your files, while muttering, "So why does s/he put Financial Spreadsheets in a file labeled 'In Your Dreams'? And the
Discretionary Fund under 'See You In Rio"?" Your boss then realized that he needed you at your computer.
Comfortably. All the time.

And who didn't go "Hey! Where can | get one of those?" in the last Die Hard movie, when the young computer hacker
literally unrolled his sealed rubber keyboard? Well, now rubber keyboards like that are on the market. And although
they look a little flimsy, they have one instant "sale feature" | can see: They are all one piece. So when you turn it
upside down and shake it, (otherwise known as "the first step to cleaning your keyboard"), you won't see false
fingernails, paper clips, hair, kitty litter, dead bugs, rubber bands, dandruff and petrified food particles dropping out.

People don't realize how vulnerable keyboards are. For the general PC user, keyboards are the main non-protected or
unsealed piece of their computer. And for the generic hard-frame keyboard, since the keys have to have room to
move, there are gaps between the keys that can become a Black Hole for anything small. Or liquid.

OK, show of hands! How many of you have called your company computer technician because your keyboard "just
died"? And the comp-tech arrives to find your nearly empty cappuccino cup on the other side of your cubicle, wads of
still-damp dark brown tissue in your wastebasket, and tiny drips or sticky spots on the desk top around your keyboard?
All while you plaster your best "l just don't know what happened ..." expression on your face?

We have a cheapo-keyboard. Otherwise known as "the keyboard that came with the computer.” It's a hard-frame
rectangle, black with white letters/numbers. Nothing fancy, but very utilitarian. The Print Screen feature has never
worked, although it may have when we first got it. That is, until my Alpha Male husband got to it. He has that
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recognizable male habit of hitting mystery keys while mumbling "So what does THIS one do? And if | hold it down at
the same time with the Control AND Alt keys...?"

| will probably never know what all the F numbered keys on the top of the keyboard are for. And I'm not going to lose
any sleep over it. But | fully expect to be sitting on a cloud in the hereafter with my husband, Mr. Inquisito, and have
him start a conversation with, "Did you know that F3 calls the Fire Department? And F12 is to issue a Nuclear Alert?"

Our generic keyboard even has several Microsoft buttons, which is kind of cool. Although | keep half-expecting a
Screen Announcement to pop up every time | use those keys, for a product-placement fee. "You just hit the Microsoft
key! Credit cards accepted!"

Our keyboard even has the standard WARNING! message: "To reduce risk of serious injury, read Safety and Comfort
Guide provided with product.” "Serious injury" is now a safety and comfort issue? Or is the "comfort" what is applied to
"seriously injured" you in the form of a pat on the shoulder, a tactile version of "Sorry, Sucker!" as the computer
company lawyer shakes his head at your lawsuit, while sagely pointing to that keyboard WARNING! message.

You've just experienced "serious injury" when the duct tape gave out and your chair collapsed, and you pulled the
keyboard down on top of you, cracking your clavicle. Spread-eagled on the floor, you casually wondered if there might
be some money to be made in this misfortune. At least enough to get a new chair that wasn't a hand-me-down from
your 500-pound uncle.

So you're in a neck brace with an arm sling at your lawyer's office. But, the computer company lawyer points out, you
never bothered to notice the embedded microscopic glyphs in that line under WARNING! By enlarging those glyphs
1,000 times, he explains, and finding somebody who can translate Ancient Babylonian, you should have been able to
read that message warning that "Once your hand touches this keyboard, you can't sue our company for anything!
Ever! We have your DNA!"

But there are other hidden dangers of "serious injury" with that innocuous keyboard. Say you spill the wrong beverage
onto your keyboard one day, and fffsssttt! Your keyboard is dead, and so are you. Your head hits the smoking
keyboard, and the letters Y, U, H, J and K are permanently seared into your cheek. Which would make for an
interesting open-casket funeral, as frowning mourners stumble past, mumbling to themselves while staring at your
cheek.

In this Age of Conspiracies, most of those mourners will be certain that you purposely left that mysterious final clue on
your cheek about who really killed you. So the very next week, the tabloids will be raging "Death By Keyboard!
Deceased Fingers YUHJK Ping Pong Manufacturer as the Real Killer!" (Hey, sometimes we have to grab our 15
minutes of fame where we can find it.)

| don't know if other wives have this problem when
sharing a computer with a large husband, but my
Lovable Lug has all the delicate "touch” of a
sledgehammer. He claims his fingertips have no
feeling anymore, after long years cooking on a grill
in restaurants. He doesn't just "tap" the keys, he
“thumps" them with enough noise that | can literally
hear him typing from several rooms away.
(Personally, I'm waiting for someone to invent a
keyboard with three levels of "adjustable touch":
female, male and Alpha Jackhammer.)
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In addition, he never learned how to type, so he hunts-and-pecks with his index fingers. Not long after we got our
current computer, | was alarmed to see that most of the letters were mysteriously disappearing from the keyboard.
There were suddenly just white flecks on most of the well-used keys. My key-pounding hubby was rubbing all the
letters off the keys!

Since | make a living as a freelance writer, | kinda need to know which key is what. If | just type and don't ook, | can
usually hit the right keys. But when | go back to make corrections, I'd increasingly be squinting at the keyboard. Was
that partial circle an O, C or Q? When my husband began complaining that he was losing points while playing his
computer games by hitting the wrongly guessed keys for Q(uit) or S(ave), | knew we had a crisis.

We decided that we didn't need to spend more money on a new keyboard, since this one worked just fine. Except that
we could no longer read most of letters on the keys. Using my feminine logic, | figured out an easy solution: fingernail
polish and a toothpick. I'd tap a blank key, and the letter would pop up on the screen. And I'd grab the toothpick and
polish.

So now we have gigantic pink letters on most of the keys that don't wear off. And except for a few mini-arguments, ("Is
that a G or a 9?") our "personalized" keyboard is now serving both of us just fine.

Marilyn K. Martin is a freelance writer of nonfiction and fiction living in East Texas. She is the author of several
published mini-articles and is currently writing a Young Adult Science Fiction series, Chronicles of Mathias, (www.
amazon.com/Chronicles-Mathias-One-Reptilian-Rebirth/dp/1598249002) Volume One and Two are
available on Amazon.
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EdgeWord: A Note from the Publisher
“Video on Cell Phones” by Jack Dunning

edge wor)p) ...
. . e Video calling on a smartphone seems to be a new trend, but do

people really want to see each other on those tiny screens?

There is a tendency to cram as many new features as possible into every new device. The only company that seems
to actually think through the usefulness of various capabilities is Apple, and even it adds more than is probably
necessary. When it comes to adding new features to a cell phone, I'm a bit of a cynic. | can understand the occasional
usefulness of a camera on the phone, but it is a capability that | can do without. When | want to take photos, | prefer to
use a real camera that might actually capture some quality. I've never used the camera on my current phone. The only
reason | have a camera at all is because it's virtually impossible to get a cell phone without a camera.

| know that there are plenty of people who use their cell cameras all of the time. Whenever there is a minor event in
their lives, they are clicking away. (I suppose that's a good thing at traffic accidents.) I've come to accept that there are
enough people who want the feature that the camera is an inevitable part of every cell phone.

The latest feature now being pushed onto cell users appears to be video calling on a smartphone. Now, instead of
merely enduring the noise of someone talking loudly on a cell phone when in a quiet restaurant, we will be annoyed
with the contorted faces of people trying to communication their emotions to the person on the other end. This is not
going to end well.

Adding video to an audio phone call is not necessarily an improvement. One of the best things about sound-only is the
fact that you cannot be seen. Most of the time, people do not want to be viewed when they answer the phone. The
only occasion when the video call feature will be turned on is when someone is ready for the event. Plus, if the time
has been taken to prepare for a video call, does a person really want to do it over the tiny screen on a handheld
phone? It would be much better to use a full-size computer (or at least a laptop) and make the viewing worthwhile.

Using Skype for video conferences with our kids and grandkids has become a regular part of our lives. What's
surprising is the excitement shown by even the youngest of the grandchildren when we magically appear on the
computer monitor—at least for the first five minutes. Nana and Grand Dad are on the computer TV. Then, once the
little ones are bored, the adults will often fall into relaxed conversation. I've seen people (my sons) stay connected with
Skype much longer then they would ever tolerate with a regular audio phone call. The video call does create a unique
environment. | don't see that happening with a cell video call.

Cell video calls will have their place in situations where there is no alternative. But people won't be using it to call their
boss about the latest client lost. (That news will probably be communicated with a text message.) | now have visions of
people walking down busy sidewalks, holding their phones at arm's length out in front of them, while engrossed in a
video call. Their inattention will cause many collisions, especially with other people engaging in the same activity.
Some may even be run over as they carelessly walk into the street—probably by a driver who is also on a video call.

The market doesn't listen to me—and probably shouldn't. I don't know who | would call with a video phone. Most
people I know wouldn't want me to see them when | call, and | certainly don't want them to see me when they call.

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 1983.

Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached at
ceeditor@computoredge.com
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Editor's Letters: Tips and Thoughts
from Readers
“Computer and Internet tips, plus comments

on the articles and columns.” by ComputorEdge
Staff

"Watch Out for Futuristic Spams," "Creating Independent Columns,"
"Windows 7 Mouse Froze," "Hard Drive Won't Boot"

Watch Out for "Futuristic” Spams

[Regarding the September 17 Beyond Personal Computing: Spam, Ham and Related Scams column:]

| did find the "e-mails from the future" pretty funny. Just so you know, this is a typical trick to get you to read these e-
mails. See Hoax-Slayer (www.hoax-slayer.com/future-date-spam.shtml). By the way, sometimes just
opening one of these e-mails sends a notification back that you are a "live" e-mail ID, so it is best not even to read
these!

Another reason | heard once is that some servers look for multiple e-mails within a very short time from the same ID as
spam, so it could be an attempt to fool those servers so that it seems that the e-mails are "spread out over time."

As a warning to your readers, though, do not unsubscribe from genuine advertisements. These are not so easy to
spot, since spammers can fake being from a legit source, and if you respond to a spammer by accident, you'll get

flooded even worse since they now know that you actually read these things. Much better advice: Use your e-mail

system to mark even these as spam. You aren't hurting that advertiser if that's what you're worried about.

But, you missed my favorite spam—from myself!! Haven't you ever gotten e-mails that seem to come from your own
ID? | have, especially on AOL since | keep that ID around for my kids. Why am | spamming myself, | ask? Multiple
personalities? Sleepwalking? Yes, spammers can make it seem that the e-mail came from your own ID to get you to
open it.

-CivWar64, Putnam County, NY
Creating Independent Columns
[Regarding the September 17 Rob, The ComputorTutor: Technology Solutions column:]

There is a simpler way to create independent columns that doesn't involve frames or section breaks. Instead, simply
insert column breaks at the points where you want new columns to begin.

-Clint Anglin, San Diego, CA
Windows 7 Mouse Froze
[Regarding the September 17 Digital Dave column:]

| think the question should be asked if you are using a wireless mouse, PS2 or USB mouse before a solution is
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attempted! It might end up being a simple solution of adjusting the BIOS to recognize legacy devices?
-Bytesponge, Columbia, MO

[If it's a wireless mouse, it might be a dead battery]! Get some rechargables. | have a Kensington, and it took a while
for me to believe the batteries were dead already.

-Marty Haase, Niwot, CO
And, if it is a wireless mouse, the batteries may be dead.
-Phil M., San Diego, CA

Pick up the mouse off the pad—you should have a bright red glow on the pad! Cordless mouse AA cell batteries only
last about 30 days unless you put the USB adapter on the bottom USB storage of the mouse—that is the on/off switch
when the mouse is not in use!

-Walter S., San Diego
Hard Drive Won't Boot

When your hard drive crashes so that it won't boot but spins and has recoverable data on it, the simplest solution may
be Spinrite (www.grc.com). You boot from the Spinrite CD and let it run. It locates and moves all readable data to
good sectors of the hard drive so that after it's done you can boot normally and have lost nothing.

-Ron Cerrato, San Diego, CA

ComputorEdge always wants to hear from you, our readers. If you have specific comments about one of our
articles, please click the "Tell us what you think about this article!" link at the top or bottom of the article/column. Your
comments will be attached to the column and may appear at a later time in the "Editor's Letters" section.

If you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at ceeditor@computoredge.
com.

Send mail to ceeditor@computoredge.com with questions about editorial content.
Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.
Copyright © 1997-2010 The Byte Buyer, Inc.

ComputorEdge Magazine, P.O. Box 83086, San Diego, CA 92138. (858) 573-0315
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